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Introduction 

How to Use this Book 

Welcome to the RISA-3D ¦ǎŜǊΩǎ DǳƛŘŜ. If you are a first-time user of RISA-3D, we recommend that you 
start with this book. This book contains step-by-step tutorials that guide you through the entire 
modeling process using most RISA-3D features. You will create a real-world example of building and 
solving a model, making changes, and optimizing the model. Several tips and shortcuts will also be 
demonstrated along the way.  

Begin by reviewing First Look at RISA-3D to familiarize yourself with the toolbars and shortcuts, then 
proceed to the step-by-step tutorials. 

To complete all the tutorials will take only a few hours. However, you can speed up the process even 
further if you skip the supporting text and concentrate only on the action steps, which are indicated 
with diamond-shaped bullets, as shown below: 

 In order for you to achieve accurate results, it is important that you do not miss any of these 
action steps while performing the tutorials. 

The tutorials build upon themselves from start to finish. You have the option of performing them all at 
one time, or performing each one separately. To make this possible, RISA provides model files for you to 
load at the beginning of each tutorial. These starter files are located in the RISA program folder under 
Tutorials, and are named RISA-3D Tutorial 2 Starter.r3d, RISA-3D Tutorial 3 Starter.r3d, etc. 

After you have gone through the tutorials in the RISA-3D ¦ǎŜǊΩǎ DǳƛŘŜ, you can use Help and the RISA-3D 
General Reference for complete, detailed information on every topic relating to RISA-3D. The topics are 
arranged in alphabetical order and are thoroughly indexed. 

If you are a more experienced user and are not sure which book will be most helpful your situation, 
consider that the tutorials in the RISA-3D ¦ǎŜǊΩǎ DǳƛŘŜ are intended to teach the basics of defining and 
solving models in RISA-3D, how and when to apply RISA-3D features to help you be most productive, 
and how to review the results. However, the more in-depth analytical aspects of RISA-3D will be covered 
in RISA-3D General Reference and the Help. For example, steel, concrete, and wood code checks will be 
performed in this guide, but the specifics of how those code checks are calculated is covered in detail in 
Help and the RISA-3D General Reference (specifically the sections titled Hot Rolled or Cold Formed Steel 
Design, Concrete Design, and Wood Design).  

Where to Download RISA-3D Book Updates 

Every effort has been made to ensure the accuracy of this book at the time of publication. The latest 
edition of all books and documents relating to this product are available in Adobe PDF format at 
http://www.risatech.com. Click Downloads, Product Documentation, then RISA-3D. 

  

http://www.risatech.com/
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Document Conventions 

The following conventions are used throughout this book: 

This convention: Indicates: 

CAPITAL LETTERS Names of keys on the keyboard ς for example, SHIFT, CTRL, or ALT. 

KEY+KEY One key should be held down and then another key pressed ς for 
example, CTRL+P or ALT+F4. 

Italic text New terms, other publications, and variable expressions ς for example, 
filename.txt. 

Bold text 

Boxed text 

  

User interface options ς for example, File menu. 

Notes or modeling tip information. 

Tutorial action item for building the model. 
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Using the Online Help 

Whether you need help on general topics, specific features, or toolbars, it is all built in to the extensive 
RISA-3D online Help system. The RISA-3D Help Menu was designed to enable you to pinpoint the Help 
information you need quickly, by offering different ways for you to access and locate that Help, as 
described below: 

 

Help on  
general topics 

On the RISA Toolbar, click the Help button . This is the fastest way to 
get help on general topics. You can also go to the Main menu and click 
Help, then select Help Topics. 

Once you enter the Help, notice the three tabs on the left: Contents, 
Index, and Search. You can explore the Help by topic using either Contents 
or Index, or explore the Help using your own specific keywords using 
Search. 

 

 

Help on a specific 
feature (context-
sensitive help) 

As you work, notice the Help buttons at the bottom of many of the dialog 
boxes. These provide direct access to the Help information related to the 
task you are performing.  

This context-sensitive help may be accessed by pressing the Help button 
on the dialog box or by pressing the F1 key. 

 

Help on toolbar 
buttons 

Are you uncertain what a toolbar button is for? Simply hold your mouse 
pointer over that button (without clicking), and a description of that 
button will be displayed. 
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Technical Support Information 

Technical support is an integral part of the software packages offered by RISA Technologies, and is 
available to all registered licensees at no additional charge. Our knowledgeable support team is ready to 
answer your most challenging questions.  

Before contacting technical support, you may want to take a few minutes to do the following: 

¶ Search the Help and all user documentation available for the product.  

¶ Search our FAQ database by visiting our website at http://www.risatech.com. Click Support, 
then Frequently Asked Questions, then choose the product. 

When you are ready to make a support request, please be prepared to send us your model, and include 
the following information: 

¶ Your name, company name, and phone number;  

¶ Product name and serial number or Key ID;  

¶ A detailed problem description; and  

¶ Your model (filename.r3d) as an e-mail attachment. If your model contains multiple 
members, plates, or load combinations, please specify which ones we should look at.  

You can contact Technical Support by e-mail, phone, or mail, as follows: 

E-mail: support@risatech.com 
E-mail is usually the best way to communicate with us when sending a model. Please include all the 
information listed above. 

Phone: (949) 951-5815 or (800) 332-RISA (7472) 
Technical support personnel are available from 6:00 A.M. to 5:00 P.M. Pacific Standard Time, Monday 
through Friday.  

Mail:  
If you prefer support via mail, please enclose all information listed above, and mail to:  
RISA Technologies, Technical Support 
26632 Towne Centre Drive, Suite 210 
Foothill Ranch, CA 92610 

RISA Technologies Online 

Visit RISA Technologies on the Worldwide Web at http://www.risatech.com for:  

¶ Answers to frequently asked questions. 

¶ Downloads of user documentation and tutorials. 

¶ Software updates ς Any known problems are posted on the website, along with possible 
work-around procedures and/or service releases to update your software. 

¶ Software verification problems. 

http://www.risatech.com/
mailto:support@risatech.com
http://www.risatech.com/
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Before You Begin 

RISA-3D Overview 

RISA-3D was designed to accelerate the time it takes to perform structural design. Computer-aided 
structural design is typically a three step process: (1) define your model, (2) solve the model to obtain 
solution results, then (3) review those solution results to see how the model performed and determine if 
changes are needed. Usually, this cycle must be repeated several times before arriving at a final, 
optimized design.  

One main reason RISA-3D is able to speed up the design process so successfully is because of its unique 
ability to define the model and make revisions both graphically (using the drawing tools) and 
numerically (using the customized spreadsheets).  

In RISA-3D, these two methods of entering and editing data work seamlessly together. Everything 
designed or drawn graphically is automatically recorded in the spreadsheets (which may be viewed and 
edited at any time)τand everything entered in the spreadsheets may be viewed and edited graphically 
at any time. As you perform the step-by-step tutorials in this guide, you will be exploring both methods 
using the drawing tools and the spreadsheets. 

Defining the Model Tips 

Keep in mind that almost all the model data can be edited either graphically (using the drawing tools) or 
numerically (using the spreadsheets). In most cases, it is simply a matter of preference as to which 
method you decide to use. Here are a few tips to consider when making your decision: 

Some data such as cross-section properties, load combinations, oddball joint coordinates, etc., are most 
easily entered numerically using a spreadsheet. Other data such as regularly spaced joints, member 
connectivity, regular loadings, and wholesale changes are better handled using graphic editing tools. 

Typically you may want to use the spreadsheets to define some preliminary information such as material 
and section properties, then proceed to the drawing grid and graphically draw the bulk of your model 
and apply loads. 

Other graphic editing features are built around RISA-35Ωǎ ƎǊŀǇƘƛŎ ǎŜƭŜŎǘƛƻƴ ǘƻƻƭǎΦ ¢ƘŜǎŜ ŦŜŀǘǳǊŜǎ ƭŜǘ ȅƻǳ 
graphically edit the model or parts of it. For example, to modify boundary conditions, you would choose 
the condition you want to apply and select the joints to modify. 

Solving the Model and Tips for Reviewing Results 

Once you have the model defined, continue by solving the model. RISA-3D features fast 32-bit solution 
speed, so your model solutions should not take long. Once the model is solved you will be presented 
with the results. 

Once again, you can review your results graphically or with the spreadsheets. Spreadsheet solution 
results (displacements, forces, stresses, etc.) are listed on the Results menu. You can sort and filter 
these results to find exactly what you want. In the graphic views, click Plot Options and choose the 
results that you want to display (force diagrams, plate contours, deflected shapes, etc.). 
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Hardware Requirements 

Minimum 

¶ Any Windows compatible computer with a Pentium 3 or better processor  

¶ Windows 2000\XP\Vista\Windows 7  

¶ 256 MB of RAM  

¶ 200 MB of hard disk space  

¶ Two or three button mouse  

¶ USB port (required for Stand-Alone version or the Network Host computer)  

Recommended 

¶ Windows XP\Vista\Windows 7  

¶ As much extended RAM as possible  

¶ As much free disk space as possible  

¶ Two button mouse with wheel  

 

Note: The amount of space needed by RISA-3D to solve a structural model is dependent on the size of 
the model. In general, 500 Mbytes of RAM is adequate to solve most problems, but the more the better, 
especially if you will be solving large problems. RISA-3D has been designed to use as much available 
RAM as possible. If there is not enough RAM, RISA-3D will use hard drive space until enough memory is 
obtained to solve the problem (causing the solution to run much slower). 

Program Limits 

Joints 100,000 

Members 32,000 

Plates 100,000 

Solids 100,000 

Section Sets 5,000 

Materials 500 

Custom Wood Species 1,000 

Diaphragms 500 

Basic Load Cases 1,000 

Loads 200,000 

Moving Loads 500 

Load Combinations 5,000 

Mode Shapes 500 

Demonstration Version: While you can open and solve a larger model, the largest model that can be 
saved to disk with the demonstration version is limited to 40 Joints, 40 Members, and 40 Plates. 
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License Agreement 

END-USER LICENSE AGREEMENT FOR RISA TECHNOLOGIES, LLC® SOFTWARE: 

The RISA-3D software product (SOFTWARE PRODUCT) includes computer software, the associated 
media, any printed materials, and any electronic documentation. By installing, copying or otherwise 
using the SOFTWARE PRODUCT, you agree to be bound by the terms of this agreement. If you do not 
agree with the terms of this agreement RISA Technologies, LLC is unwilling to license the SOFTWARE 
PRODUCT to you. In such event you must delete any installations and destroy any copies of the 
SOFTWARE PRODUCT and return the SOFTWARE PRODUCT to RISA Technologies, LLC within 60 days of 
purchase for a full refund. 

Copyright 2010 by RISA Technologies, LLC. All rights reserved. The SOFTWARE PRODUCT is protected by 
United States copyright laws and various international treaties. All rights not specifically granted under 
this agreement are reserved by RISA TECHNOLOGIES, LLC.  

1. SOFTWARE LICENSE. The SOFTWARE PRODUCT is licensed, not sold. All right, title and interest is and 
remains vested in RISA TECHNOLOGIES, LLC. You may not rent, lease, or lend the SOFTWARE PRODUCT. 
You are specifically granted a license to the use of this program on no more than one CPU at any given 
time. The Network Version of the SOFTWARE PRODUCT is licensed for simultaneous use on a certain 
maximum number of network stations that varies on a per license basis. As part of the license to use the 
SOFTWARE PRODUCT, the program user acknowledges the reading, understanding and acceptance of all 
terms of this agreement. The SOFTWARE PRODUCT may not be reviewed, compared or evaluated in any 
manner in any publication without expressed written consent of RISA Technologies, LLC. You may not 
disassemble, decompile, reverse engineer or modify in any way the SOFTWARE PRODUCT. If the 
SOFTWARE PRODUCT was purchased at a discounted price for educational purposes it may in no event 
be used for professional design purposes. The terms of this license agreement are binding in perpetuity. 

2. DISCLAIMER. We intend that the information contained in the SOFTWARE PRODUCT be accurate and 
reliable, but it is entirely the responsibility of the program user to verify the accuracy and applicability of 
any results obtained from the SOFTWARE PRODUCT. The SOFTWARE PRODUCT is intended for use by 
professional engineers and architects who possess an understanding of structural mechanics. In no 
event will RISA Technologies, LLC or its officers be liable to anyone for any damages, including any lost 
profits, lost savings or lost data. In no event will RISA Technologies, LLC or its officers be liable for 
incidental, special, punitive or consequential damages or professional malpractice arising out of or in 
connection with the usage of the SOFTWARE PRODUCT, even if RISA Technologies, LLC or its officers 
have been advised of or should be aware of the possibility of such damages. RISA TECHNOLOGIES, LLC' 
entire liability shall be limited to the purchase price of the SOFTWARE PRODUCT. 

3. LIMITED WARRANTY. RISA Technologies, LLC warrants that the SOFTWARE PRODUCT will operate but 
does not warrant that the SOFTWARE PRODUCT will operate error free or without interruption. RISA 
Technologies, LLC sole obligation and your exclusive remedy under this warranty will be to receive 
software support from RISA Technologies, LLC via telephone, e-mail or fax. RISA Technologies, LLC shall 
only be obligated to provide support for the most recent version of the SOFTWARE PRODUCT. If your 
version of the SOFTWARE PRODUCT is not the most recent version RISA Technologies, LLC shall have no 
obligation to provide support in any form. Except as stated above the SOFTWARE PRODUCT is provided 
without warranty, express or implied, including without limitation the implied warranties of 
merchantability and fitness for a particular purpose.  

4. PROTECTION DEVICE. In the event the SOFTWARE PRODUCT requires the use of a PROTECTION 
DEVICE to operate, you are specifically prohibited from attempting to bypass the functionality of the 
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PROTECTION DEVICE by any means. If the PROTECTION DEVICE becomes broken or inoperable it should 
be returned to RISA TECHNOLOGIES, LLC for a replacement. The replacement will not be provided if RISA 
TECHNOLOGIES, LLC cannot affirm that the broken PROTECTION DEVICE was originally provided by RISA 
TECHNOLOGIES, LLC for use with the SOFTWARE PRODUCT. A lost or stolen PROTECTION DEVICE will not 
be replaced by RISA TECHNOLOGIES, LLC. 

5. TERMINATION. RISA TECHNOLOGIES, LLC may terminate your right to use the SOFTWARE PRODUCT if 
you fail to comply with the terms and conditions of this agreement. In such event you must delete any 
installations and destroy any copies of the SOFTWARE PRODUCT and promptly return the SOFTWARE 
PRODUCT to RISA Technologies, LLC. 

6. CHOICE OF LAW. By entering into this Agreement in accordance with Paragraph 1, you have agreed to 
the exclusive jurisdiction of the State and Federal courts of the State of California, USA for resolution of 
any dispute you have relating to the SOFTWARE PRODUCT or related goods and services provided by 
RISA Technologies, LLC. All disputes therefore shall be resolved in accordance with the laws of the State 
of California, USA and all parties to this Agreement expressly agree to exclusive jurisdiction within the 
State of California, USA. No choice of law rules of any jurisdiction apply. 

"RISA" as applied to structural engineering software is a trademark of RISA Technologies, LLC. 

Installation 

Installation Instructions 

To install RISA-3D: 

¶ Place the RISA-3D CD in your computer CD drive. If the CD starts automatically, skip the 
remaining steps, and follow the on-screen instructions. 

¶ If the CD does not start after 10 seconds, click the Windows Start button and select Run. 

¶ In the Run ŘƛŀƭƻƎ ōƻȄΣ ǘȅǇŜ άd:\ launchsetupέ όǿƘŜǊŜ άŘέ ƛǎ ǘƘŜ ƭŀōŜƭ ƻŦ ȅƻǳǊ /5 ŘǊƛǾŜύΣ ŀƴŘ 
then click the OK button. 

¶ Follow the on-screen instructions. 

RISA-3D Customization--Important Assumption! 

Please ensure that when performing these tutorials, RISA-3D has not been customized in any way, and is 
in the default, installed state. If the installation of RISA-3D has been customized, you may reset the 
program defaults as follows: on the Tools menu, select Preferences, click the Reset Customization 
Options to Their Original Settings button. 

Maintenance 

Program maintenance is highly recommended and provides all upgrades to RISA-3D, technical support, 
and discounts on new products.  

Complete initial program support is available to registered owners of RISA-3D and is included in the 
purchase price. This initial support is provided for as loƴƎ ŀǎ ǘƘŀǘ ǾŜǊǎƛƻƴ ǊŜƳŀƛƴǎ ǘƘŜ άŎǳǊǊŜƴǘέ ǾŜǊǎƛƻƴ 
of the program. When a new version of RISA-3D is released, if your maintenance has not been renewed, 
you will no longer have access to technical support or program updates. 

RISA Technologies will support only the current version of RISA-3D. For a list of your support options, 
visit our website: www.risatech.com/support. 

http://www.risatech.com/support
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First Look at RISA-3D 

Starting RISA-3D 

This section describes the RISA-3D user interface, the toolbars, and shortcuts. We recommend that you 
review this section before you begin the tutorials. However, if you are already familiar with the RISA-3D 
user interface, feel free to skip ahead to Tutorial 1. 

Start RISA-3D as follows: 

 On the Start button, click All Programs, select RISA, then select RISA-3D. 

 

The RISA-3D Windows and Dialog Boxes 

 

 

 

Title Bar Main Menu RISA Toolbar Minimize   Maximize/Restore  Close 

Status Bar Workspace Data Entry Toolbar 
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Title bar The title bar at the top of your RISA-3D window can be very useful. Besides containing the 
name of the file that is currently open, it can also be used to move the window and 
minimize, maximize, and resize the window.

 

To move the window, press and hold the title bar with your mouse, then drag to the 
desired location.  

Minimize, 
Maximize, 
Close 

The three buttons on the right of the title bar control the RISA-3D window as follows: 

¶ Click Minimize to minimize the window to a button on the taskbar. 

¶ Click Maximize to maximize the window to full screen. Once it is full screen, 
click Restore Down to restore the window down to its original size. 

¶ Click Close to close the window. 

Workspace The actual work that you do in RISA-3D will be in the main area on the screen, the 
workspace. Currently the workspace contains a white model view with the default 
drawing grid and the Starting a Model options (you will see how to change the default 
grid and many other defaults as you go through the tutorials). As you create new model 
views and spreadsheets, they will also appear in the workspace. 

Status bar The Status bar at the bottom of your screen will report information about your model as 
you work in RISA-3D. The bar has four parts:  

¢ƘŜ ƭŜŦǘ ǎƛŘŜ ƻŦ ǘƘŜ ōŀǊ Ƙŀǎ ǘƘŜ ƭŜǘǘŜǊǎ ά{έΣ ά5έΣ ŀƴŘ άwέ ǘƻ ƛƴŘƛŎŀǘŜ ǘƘŜ ǎƻƭǾŜŘ 
state of the model for Static, Dynamic, and Response Spectra solutions. If the 
letters are dimmed, a solution has not been performed. After performing a 
solution, the letters will become blue in color with a red checkmark on them (as 
shown below). 

 

To the right of the solved status flags are three status boxes which display information 
while you work: 

¶ The first status box displays general information relative to the task you are 
performing. 

¶ The second (middle) status box reports the units of the current spreadsheet 
cell. As you move from cell to cell, look to the middle status box for the 
appropriate units. This box is empty if you are not working in a spreadsheet. 

¶ The third status box (on the far right) reports the cursor coordinates as you 
work in the model view. This will be demonstrated throughout the tutorial. 

Dialog 
boxes 

Dialog boxes are windows that help you perform a specific function within RISA-3D. For 
example, on the File menu, click Open and the dialog box below will display which helps 
you locate the file you would like to open. Many of the dialog boxes also contain Help 
buttons that will direct you to the related topic in Help. 
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Menus  

Main Menu 

 

The main menu and its submenus provide access to all features RISA-3D has to offer, as summarized 
below: 

File Provides access to file operations such as opening, saving, importing, exporting, 
and appending files. 

Edit Provides editing tools that help you modify and manipulate the spreadsheets. 
You may use this menu to add or remove information from the spreadsheets or 
to sort and mathematically manipulate current spreadsheet data. 

Global Allows you to set options that apply to the entire model such as design codes, 
shear deformation and warping effects, p-delta options, model descriptions, 
and notes. 

Units Allows you to set units or convert existing units. 

View Allows you to open a new model view or adjust the current model view. 

Insert Used to insert joints, members, plates, and loads into the model. All of these 
items may be drawn graphically or entered in the spreadsheets. This menu 
provides access to the graphical methods while the Spreadsheets menu 
provides access to the spreadsheets. 

Modify Allows access to the graphic editing features and may be used to modify 
existing joints, members, plates, and loads. 

Spreadsheets Opens the spreadsheets. 

Solve Allows access to the analysis options provided with RISA-3D. 

Results Allows access to all analysis result spreadsheets. This button is dimmed when 
no results are available, such as before you run a solution. 



First Look at RISA-3D 

12 

Tools Provides tools to help you organize, identify, and correct problems as you 
model the structure. Preferences are also located here. 

Window Manages all of the windows that you have open in RISA-3D, whether they are 
spreadsheets or model views. Special tiling options are also available that relate 
to specific modeling tasks. 

Help Allows access to the RISA-3D online Help. For more information on Help, see 
the Using the Online Help section. If you are connected to the internet, you may 
also check to see if any product updates are available. 

Director If your RISA-3D model is linked to a RISAFloor model or a RISAFoundation 
model, this menu allows you to switch between programs. 

Toolbars 

The most commonly used features available on the Main menu are also available on the toolbars as 
toolbar buttons. The toolbars are designed to speed up your workflow by placing these tools close to 
your workspace and making them easily visible.  

If at any time you are not sure what a particular toolbar button does, simply position your mouse over 
the button and a short definition will display. 

Note: You will discover many options to access the features available in RISA-3D. The methods you 
chooseτwhether menus, toolbars, or keyboard shortcutsτwill simply be a matter of personal 
preference. 
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RISA Toolbar 

 

The RISA toolbar is located directly below the Main menu. Unlike some of the other toolbars, the RISA 
toolbar never changes. These buttons perform general actions such as opening and closing files, 
changing design parameters, printing, and solving the model.  

Window Toolbar 

Χƛƴ Model View 

 

The window toolbar is located directly below the RISA toolbar. When working in a graphic model view, 
the buttons provide model viewing tools, such as rotate and zoom, and others. 

Χƛƴ Spreadsheet View 

 

When you are working in a spreadsheet, this toolbar provides spreadsheet editing tools, such as Block 
Fill and Block Math. 

Drawing Toolbar 

 

The drawing toolbar provides tools to assist with creating and modifying your model graphically. This 
toolbar may be turned on and off (CTRL+G) as needed. 

Selection Toolbar 

Χƻƴƭȅ ǾƛǎƛōƭŜ ƛƴ Model View 

The Selection toolbar is the vertical toolbar along the left side of the screen.  
It provides selection tools to help you work with parts of the model.  

You will need to make selections when you do things like graphically edit only  
part of the model or print only part of the results.  
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Spreadsheet Toolbars  
(Data Entry and Results Toolbars) 

These two toolbars provide quick access to the spreadsheets. You can 
turn them on and off on the RISA toolbar by clicking the Data Entry 

button or the Results button . 

The Data Entry toolbar is a vertical toolbar on the right of your  
screen. It looks different than the other toolbars because its  
buttons consist of text instead of images.  

The Results toolbar is very similar. It appears after the model has been 
solved and provides quick access to the results spreadsheets. 

Both toolbars allow you to access the spreadsheets very quickly while 
building and solving your model. The buttons appear in the general 
order as you may need them.  

Managing Windows 

As you work in RISA-3D, you will be working within model views and spreadsheets, each in their own 
window that may be moved around the workspace and resized as you wish. A powerful feature of RISA-
3D is the ability to have multiple model views and spreadsheets open at one time. The Window menu 
provides many options to help manage the display of these windows. 

 

 

 

 

 

Minimize, 
Maximize, and 
Close buttons 

Scroll 
arrows & 
scroll bar 

Scroll bar ς to view information 
ƻǳǘǎƛŘŜ ƻŦ ǘƘŜ ǿƛƴŘƻǿΩǎ ǾƛŜǿŀōƭŜ 
area, drag the scroll bar to move the 
display. 
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Managing Model Views 

You may open as many model view windows as you like. This is especially helpful when working zoomed 
in on large models. You might have one overall view and a few views zoomed in and rotated to where 
you are currently working. You may have different information plotted in each view. 

Remember that the toolbars displayed by RISA-3D vary depending on which window is active (the 
window with a colored title bar is the active window).  

For example, if your active window is a spreadsheet, and you are looking for the zoom toolbar, you will 
not be able to locate it until you click on your model, switching to model view. Then you will be able to 
access the zooming tools, and all the other tools related to modeling. 
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Working in Spreadsheets 

Spreadsheets provide a means to enter and edit model data numerically. Spreadsheets are comprised of 
rows and columns of cells. To add or edit data in a cell, click on the cell, making it the active cell, then 
type. There is always only one active cell at a time, and is indicated with green color. Notice you can 
change which cell is active using the LEFT ARROW, RIGHT ARROW, PAGE UP, PAGE DOWN, HOME keys, 
etc. 

You may also select blocks of cells to work on. To select a block of cells, click and hold the mouse button 
in the first cell in the block, drag to the last cell in the block, then release the mouse. To select an entire 
row or column, simply click the row or column label. To select multiple rows or columns, click and drag 
the mouse across multiple row or column buttons. 

 

 

 

 

 

Scroll arrows Active cell 
Column label ς  

To select the entire column, click the label. 

To resize the column, click the line to the right of the 
label and drag to the right. 

Scroll bar 

Row of cells ς 

Click the row label 
(at left) to select the 
entire row. 

Column of cells 
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Tutorial 1 ς Modeling 

This is the first tutorial in this series designed to guide you through the entire modeling process using 
many RISA-3D features. ¢ƘŜ ǘǳǘƻǊƛŀƭǎ ŀǊŜ ƛƴǘŜƴŘŜŘ ǘƻ ǎƛƳǳƭŀǘŜ ǘƘŜ άǊŜŀƭ ǿƻǊƭŘέ ŘŜǎƛƎƴ ǇǊƻŎŜǎǎΦ Just as in 
the real world, you will enter the data, solve the model, review results, then go back and make changes, 
etc. We believe the real test of any solutions software is in the design modificationτnot just the initial 
design. See for yourself how easily you can design and change your model using RISA-3D. 

In the tutorials ahead, you will be modeling this structure: 

 

As you perform the step-by-step tutorials, you will make use of both the spreadsheet and graphic 
drawing capabilities of RISA-3D. In Tutorial 1, you will create a 2-D frame comprised of a concrete frame 
supporting a steel angle truss. In Tutorial 2, you will άŜȄǘǊǳŘŜέ ǘƘƛǎ ƛƴǘƻ ŀ о5 ƳƻŘŜƭΣ ŀŘŘ ǎǘŜŜƭ and glulam 
beams, girts, a masonry wall panel, and plates. Tutorial 3 will show how to define loads in the model. In 
Tutorial 4, you will run a static solution and review the results. Tutorial 5 will demonstrate dynamic 
analysis and seismic design. Then, Tutorial 6 will explore the various options for ineroperability of RISA-
3D with other programs such as other RISA programs, Revit Structure, and CAD programs. 

The tutorials build upon themselves from start to finish. You have the option of performing them all at 
one time, or performing each one separately. To make this possible, RISA provides model files for you to 
load at the beginning of each tutorial. These starter files are located in the RISA program folder under 
Tutorials, and are named RISA-3D Tutorial 2 starter.r3d, RISA-3D Tutorial 3 starter.r3d, etc. 

To complete all the tutorials will take only a few hours. However, you can speed up the process even 
further if you skip the supporting text and concentrate only on the action steps, which are indicated 
with diamond-shaped bullets, as shown on the next page: 
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 In order for you to achieve accurate results, it is important that you do not miss any of these 
action steps while performing the tutorials. 

Now, if you are ready to get started, start RISA-3D if you have not already done so: 

 Double-click the RISA-3D icon to start the program. The Starting a Model dialog box will display, 
which allows you to create a new model or open an existing file.  

 

Note: The appearance of your menus and toolbars may look slightly different than the above image, 
depending on your computer screen resolution and font sizes. 

Starting a Model Options 

The Starting a Model dialog box presents you with several startup options, along with a blank drawing 
grid placed in the workspace. You can choose to start drawing your model (by defining members, plates, 
or using a template to generate it automatically), open an existing model, or work on your own (by 
clicking Close ). 

Automatically Generating with Templates 

RISA-3D has powerful templates that automate the generation of structures. Although these templates 
are not used in the tutorials, we believe that once you understand how to model structures without the 
templates, you will easily understand the benefit of the templates for your future modeling projects, 
making RISA-3D even more powerful. 

These templates can be accessed as follows: 

On the Insert menu, click Structure (Generate). 

-OR- 

On the RISA toolbar, click the Perform High Level Generation button .  
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Some of the templates are very specific, such as the Rectangular Tank with Stiffeners or the General 
Truss generator. Some are general, such as the Circular Disk With Plates. Using these templates, you can 
generate almost any typical or repetitive model or model component.  

Create a New Model 

You will now begin to model your structure by first creating a 2D frame, defining your Global 
Parameters, your drawing grid, and be introduced to some basic graphical modeling.  

 Under Create a New Model, make sure the Open the Global Parameters window also check 
box is selected. This will save you a step by opening the Global Parameters dialog box once you 
make your starting selection. 

 Select Click here to immediately start drawing members . 

The Global Parameters dialog box should now display. 

  

Set Global Parameters 

Set the Global Parameters as follows: 

 Type the model title, company name, and your name, as shown above.  

 Click Apply. The dialog box will remain open. 

Review and modify the Solution parameters: 

 In the Global Parameters dialog box, click the Solution tab.  

 In the Number of Sections box, type 7 (or you may use the up/down arrows to 
increase/decrease the value). In the INTERNAL Sections box, select 100.  

 Select the Shear Deformation, Torsional Warping, Transfer Load Between Intersecting Wood 
Wall, and Increase Nailing Capacity for Wind check boxes. 

Tip: 

Press TAB to advance to the 
next field. 

Type any notes you would like 
to keep with the model in the 
Notes area. 

Global Parameters are settings 
that apply to the model as a 
whole. 
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 Click Apply. 

The dialog box will remain open, and should now look like this: 

 

 

Below is a description of all the available solution parameters: 

Number of Sections Specify how many locations along each member are to be used for the 
reporting of forces, stresses, and deflections. For this tutorial, you will 
specify the calculations be reported at 7 section locations. 

Number of Internal 
Sections 

Controls how many places along each member RISA-3D calculates and 
stores results, such as deflections and code checks. The member force 
diagrams displayed in the model view and the detail plot are also drawn 
from these results. 

Shear Deformation This check box indicates whether or not shear deformation considerations 
are to be included in the model solution. This check box is usually selected 
and is the default setting. 

Torsional Warping This check box indicates whether or not torsional warping effects are 
considered when calculating stiffness and stress values for wide flange and 
channel shapes. 

Transfer Load 
Between Intersecting 
Wood Wall 

 

This check box indicates whether or not to transfer loads between 
perpendicular wall panels framing into each other. 
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Increase Nailing 
Capacity for Wind 

This checkbox indicates if you want to increase the shear capacity of wood 
wall panels and diaphragms by 1.4 for all load combinations that contain 
wind loads. 

Area Load Mesh Controls how many discrete areas the load is broken into before it is 
attributed to the members. 

Merge Tolerance Defines the maximum distance two joints can be apart from each other yet 
still be merged together. Also used when scanning for crossing members 
and for unattached joints along the spans of members. 

P-Delta Tolerance Used to set the convergence tolerance for the P-Delta analysis. 

Mesh Size Controls the base mesh size to be used when wall panel elements are 
solved. 

Gravity Acceleration  Used for dynamics and will be discussed later. 

Eigensolution Used for dynamics and will be discussed later. 

Vertical Axis Indicates which of the three global axes (X, Y or Z) is to be considered the 
vertical axis. For this tutorial, leave this set to Y indicating the global Y-axis 
is the vertical axis. 

Solver Select the solver to be used during solution. Please see the help menu for 
more information on this option. 

Member Default 
Orientation 

Set the default member orientation. Please see the Help menu for more 
information on this option. 

 

Review the options for the Code parameters: 

 In the Global Parameters dialog box, click the Codes tab.  

For this tutorial, the default settings will be used. 
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These settings control how code checking is performed, as described below:  

Hot Rolled 
Steel 

Code choices include 13th Edition ASD & LRFD, 9th Edition ASD, 2nd Edition LRFD, 3rd 
Edition LRFD, and several international steel codes.  If the AISC 13th Edition code is 
selected (either ASD or LRFD), the Adjust Stiffness check box will appear. If selected, 
stiffness reduction provisions will be initiated, as listed in Appendix 7 (Direct Analysis 
Method) of the code. 

Cold Formed 
Steel 

Code choices are AISI 99: ASD & LRFD, AISI 01: ASD & LRFD, and several international 
codes. 

Wood, 
Concrete, 
Masonry 

Design codes also include the standard US codes along with several international 
codes. 

Review and modify the options for the Concrete parameters: 

 In the Global Parameters dialog box, click the Concrete tab.  

 Under Biaxial Column Design, click Exact Integration Method. This method is the more accurate 
of the two methods and does not require you to make an estimate of the Parme Beta Factor. 

 Under Concrete Stress Options, click Parabolic Stress Block. This method is the more accurate 
of the two methods. 

 Click Apply. 

 

 

 

 

 

Save as Defaults ς 

At any time during the 
modeling process, you can 
click this button to save all the 
settings to become the new 
default settings for all future 
models. 

Click the Help button to open 
the Help Menu to the relavent 
topic. 
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These settings contain options related to the analysis and design of concrete members as described 
below:  

Shear Tie  Allows you to control the number of shear regions that will be used when 
detailing a beam or column span. It also allows you to specify an increment when 
increasing or reducing the spacing of the shear ties. 

Biaxial Column 
Design 

Controls which method will be used to determine the biaxial column capacity: 
the Exact Integration Method is more accurate than the PCA Load Contour 
Method and does not require you to make an estimate of the Parme Beta Factor.  

Concrete Stress 
Options 

Allows you to choose what type of stress block to consider in your analysis. The 
options are the constant Rectangular Stress Block and the Parabolic Stress 
Block. Since the parabolic block is more accurate, you will select this stress 
distribution for your design. 

Concrete Rebar 
Set 

Specify the grade of rebar you wish to use. You can also specify a Minimum % 
Steel and Maximum % Steel for column reinforcement. 

Concrete check 
boxes 

Used Cracked Sections - modifies the member stiffnesses by the Icr factor. For 
more information, refer to RISA-3D General Reference.  

Bad Framing Warnings - helps you detect modeling errors during solution. It 
produces a message in the error log whenever an unsupported member is 
detected at either of its end joints (can be common for models that contain 
cantilevers, rafters, etc.)  

Unused Force Warnings - produces messages on the member detail report when 
weak axis and torsional moments have been neglected. 

Minimum 1 Bar Dia Spacing - allows a minimum spacing of one bar diameter 
between parallel bars. Otherwise, RISA-3D will default to a two bar diameter or 
one inch clear spacing, whichever is greater, to allow for lap splices and continue 
to maintain adequate spacing between parallel bars. 

 

Before closing the Global Parameters dialog box, notice you will also see a tab labeled Footings. If you 
have RISAFoot installed, this will allow you control over footing design input. If you do not have 
RISAFoot installed, this tab will only state that you need to install the program in order to utilize the 
integration. For more information on this integration, please click Help or refer to RISA-3D General 
Reference. 

You may now close the Global Parameters dialog box. 

 Click OK to exit.  

Members 

Once you close the Global Parameters dialog box, the Draw Members dialog box will display, which is 
shown on the next page: 
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Before drawing the members, first define the material type to be used, either: Hot Rolled, Cold Formed, 
Wood, Concrete, or General. Once the materials are stored in RISA-3D, the spreadsheets and solution 
results will be sorted based on that material. When performing a solution, RISA-3D will only analyze 
and/or design members for load combinations that are appropriate for that material (this will be 
discussed in more detail in Tutorial 3 ς Loading). 

Define concrete as the material type for your new members you will be creating: 

 Under Member Material Type and Shape, click Concrete. 

Next, you need to decide how you want to define the cross-sectional properties of the member. You can 
assign a shape directly, or define your properties based on section sets.  

For now, start with a 12x12 column, and assign your concrete shapes directly. (Later you will use section 
sets for your wood truss and steel members.) 

 Click Assign Shape Directly. 

This bypasses the section sets and allows you to assign an explicit shape for these new members: 

 Under Start Shape, type: CRECT12X12 

 Under Design List, select Rectangular. 

 Under Type, select Column. 
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The dialog box should now look like this: 

 

Member Releases 

Under Release Codes, Fully Fixed at Both Ends will be used for this tutorial. You may now begin drawing 
columns. 

 Click Apply to begin drawing columns. 

Note: When you enter the drawing mode, your cursor changes to . Also, on the Drawing toolbar, 
notice the Draw New Members button is pressed in. 

Drawing Grid 

Before you begin drawing, notice that RISA-3D will always open a default 30x30 grid spaced at one foot. 
To make it easier to find your column and beam locations for this tutorial, redefine the grid as follows: 

 On the Drawing toolbar, click the Modify Drawing Grid button to redefine the grid. The Drawing 
Grid tab should already be selected. 

The drawing grid may be specified in plane or in either elevation. For this model, leave the drawing grid 
in the XY plane, and change the grid settings as follows: 

 Under Grid Plane, click XY. 

 Under Rectangular Grid Increments, in the first column under X Axis, highlight and delete any 
current data and type: 3,4@3.75,3 (including the commas).  

The Release Codes selection 
designates how each 
member is considered 
connected at its end joints. 

 

Tip: 

Use Release Codes to specify 
how members are attached 
ǘƻ ƻƴŜ ŀƴƻǘƘŜǊΦ [ŀǘŜǊΣ ȅƻǳΩƭƭ 
explore using Boundary 
Conditions to specify how the 
structure is attached to its 
external points of support 
(reactions). 
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 In the first column under Y Axis, highlight and delete any current data and type: 10,8.5,4 
(including the commas). 

The dialog should now look like this: 

 

Close the Drawing Grids dialog box and the Data Entry toolbar. 

 Click OK to close the dialog box.  

 Click Close to close the Data Entry toolbar (upper right corner of your workspace). 

Drawing Members 

As you move your cursor around the drawing grid (specifically over grid intersections), notice RISA-3D 
displays the coordinate location of the cursor in the lower right corner of the Status bar. 

 

 

 

 

The coordinates displayed on the Status bar are the coordinates of the grid point or joint location closest 
to the cursor. Notice the coordinates change as you move the mouse around. Also, when you are in the 
drawing mode (as you are now), the points are highlighted by a red dot any time the tip of your mouse 
approaches the point.  

Status bar. Coordinates of the current grid 
intersection location of the mouse. 



Tutorial 1 ς Modeling 

27 

 

Start by drawing a line from point A to point B, as shown in the image above: 

 Place the cursor on the lower left corner of the grid to create point A (coordinates 0,0,0) and 
click once. (Notice a joint has been created and labeled N1.) 

 Next, move the mouse straight up to point B (coordinates 0,18.5,0) and click again. (Another 
joint has been created and labeled N2.) 

 When finished drawing the line, press the right mouse button to release the mouse. 

 

To release the mouse: 

Press the right mouse 
button or ESC when done 
drawing. 

 

To undo any mistakes:  
Press the Undo button or 
CTRL+Z. 

Grid Locations: 

Point A (0,0,0) 
Point B (0,18.5,0) 

As you continue the tutorial, 
ensure that you draw the 
members in the specified 
location by watching the 
Status bar to verify the exact 
coordinate location. 
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Draw another line from point A to point B, as shown in the image above: 

 To create point A, place the cursor on the lower right corner of the grid (coordinates 21,0,0) and 
click once. (The new joint has been created and labeled N3.) 

 Next, move the mouse straight up to point B (coordinates 21,18.5,0) and click again. (The new 
joint has been created and labeled N4.) 

 When finished drawing the line, press the right mouse button to release the mouse. Click the 
right mouse button a second time to exit the drawing mode. 

Now you should have a column on the left, extending from joint N1 to joint N2, and another on the 
right, from joint N3 to N4. 

Before drawing the truss, take a moment to change the way that members are shown and color-code 
them by their section sets. 

 On the Window toolbar, click Plot Options . 

Grid locations: 

Point A (21,0,0) 
Point B (21,18.5,0) 
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The Plot Options will be discussed in more detail later. For now, just change the color coding: 

 In the dialog box, click the Members tab. 

 Click Color Coded. Under Color Basis, select Section Set. Under Labeling, select No Labeling. 

 

 Click OK to close the dialog box and return to the plot. 

The members should now be displayed in color and a legend is now displayed in the upper right corner 
ƻŦ ǘƘŜ ǿƻǊƪǎǇŀŎŜΦ bƻǘƛŎŜ ǘƘŀǘ ǘƘŜ ŘŜǎŎǊƛǇǘƛƻƴ ŀǇǇŜŀǊǎ ƛƴ ǘƘŜ ƭŜƎŜƴŘ ŀǎ άnaέ ōŜŎŀǳǎŜ ǘƘŜ ǎŜŎǘƛƻƴ ǎŜǘs 
have not yet been defined. 
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Now that the columns are defined, move ahead to the truss members. To resume drawing: 

 On the Drawing toolbar, click the Draw New Members button .  

You will now define your truss members as you would a section set. This allows you to group similar 
members for easier modeling and modifying. Because you have not yet defined any section sets, you will 
first place the members in the sets as you build the model, then define the properties (section sets) 
later. 

 Under Member Material Type and Shape, select Hot Rolled. 

 Then click Assign a Section Set to assign a section set for your new members. (The available 
options for Hot Rolled Steel will appear.) 

 

 Click Apply to return to the model view and resume drawing. 
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Draw the truss chord, as shown on the image above: 

 Draw members from points A to B, then B to C, then C to D, and lastly from D to A.  

 Click the right mouse button or ESC to release the mouse. 

 Click the right mouse button or ESC again to exit the drawing mode. 

Next, you will draw the web members using the HR1A section set again. Later, you will modify this to 
differentiate the web members from the truss chords using separate section sets. 

 Click the right mouse button (from anywhere in your workspace) to activate the shortcut menu. 

 

Note: Because the truss chords were 
defined as a section set, they are 
displayed in a different color than the 
columns. 

Press the right mouse 
button to activate the 
Shortcut menu. 

Grid Locations: 

Point A (0,18.5,0) 
Point B (21,18.5,0) 
Point C (18,22.5,0) 
Point D (3,22.5,0) 
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The shortcut menu displays options available that relate to the tasks you are performing. These options 
are specific to your current view. For example, if you were viewing a spreadsheet, the choices would be 
relevant to spreadsheets. 

 Select Recall Last Dialog (or CTRL+D) to display the Draw Members dialog box again. 

 Under Release Codes, click Pinned at Both Ends. 

The dialog box now looks like this: 

 

Exit the dialog box: 

 Click Apply. 



Tutorial 1 ς Modeling 

33 

Draw the web members, as shown below: 

 

 

 Draw members from points A to B, B to C, C to D, D to E, then lastly from E to F.  

 Click the right mouse button or press ESC to release the mouse. 

Choose a new starting point for the next series of members. 

 

Draw the next series of members, as shown above. 

 Draw members from points A to B, B to C, C to D, then lastly from D to E.  

 Click the right mouse button or press ESC to release the mouse. 

  

Grid Locations: 

Point A (3,22.5,0) 
Point B (3,18.5,0) 
Point C (6.75,22.5,0) 
Point D (6.75,18.5,0) 
Point E (10.5,22.5,0) 
Point F (10.5,18.5,0) 

Grid Locations: 

Point A (18,22.5,0) 
Point B (18,18.5,0) 
Point C (14.25,22.5,0) 
Point D (14.25,18.5,0) 
Point E (10.5,22.5,0) 
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The image should now look like this: 

 

Physical Members 

Notice that you have defined your truss chords with one member, rather than multiple members 
between each joint. RISA-35Ωǎ Physical Member feature allows you to quickly draw in members this way, 
rather than making you draw every member as split between nodes. 

Physical Members automatically connect the members and nodes that frame into them along their 
midspan. Therefore, you do not have to use multiple members to model what is one Physical Member in 
the field. Therefore, if you later have to make changes to your model, you do not have to apply changes 
to multiple smaller members. Most important, the results values for this continous member will not be 
spread out over multiple members, making it difficult to find design values, it will instead be presented 
as that of only one member.  

Material Properties 

As yet, no material properties have been defined. The material properties will be defined next using the 
Materials spreadsheet. 

Re-open the Data Entry toolbar you closed earlier: 

 On the RISA toolbar, click the Data Entry button to display the Data Entry toolbar.  

 On the Data Entry toolbar, click Materials. 






































































































































































































































